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1 Software Log-Graph

Versão 1.0.2

O software possibilita a operação dos Registradores 
Log10/100/110/110EXF através de um computador com sistema 
operacional Windows por meio de uma entrada USB. É responsável pela 
configuração do Registrador, leitura/exibição e arquivamento dos dados 
registrados. Os parâmetros incluem todas as funções disponíveis no 
Registrador.

O conteúdo deste manual fornece uma visão geral de todas as funções do 
software Log-Graph. 
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2 Introdução

Nesta seção descreveremos a instalação do software Log-Graph e 
seu uso em conjunto com os registradores Log10/100/110/110EXF.

O software possibil ita a operação dos registradores 
Log10/100/110/110EXF através de um computador com sistema 
operacional Windows por meio de uma entrada USB. É responsável pela 
configuração do registrador, pela leitura dos dados registrados e apóia 
todas as funções disponíveis no registrador. Os registradores 
Log10/100/110/110EXF são distinguíveis uns dos outros pelo fato de que 
os dois primeiros incorporam um sensor de temperatura puro, enquanto 
que os dois últimos possuem um sensor combinado de temperatura e 
umidade. Os registradores Log10 e Log100 só fornecem dados de 
temperatura, os registradores Log110 e Log110EXF fornecem dados de 
temperatura e umidade a partir dos quais o ponto de orvalho 
(condensação) é calculado. Um sensor externo de temperatura adicional 
pode ser conectado pela entrada USB  do registrador. (exceto Log10).

O registrador só pode ser operado usando os botões Start/Stop e 
Mode. A configuração do registrador e a leitura dos dados são realizadas 
somente através do software Log-Graph.

IMPORTANTE:

O manual é baseado no funcionamento dos modelos 
Log100/110/110EXF. O Log10 também é gerenciado pelo mesmo 
software, porém suas funcionalidades são mais limitadas em 
comparação com os outros modelos. Verifique o manual do aparelho 
específico para saber se ele atende às suas necessidades.
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A conexão do registrador com o computador é feita usando um cabo 
USB adequadamente conectado a uma das entradas do PC. Ao conectar 
o registrador, a entrada USB é configurada como entrada COM virtual  
através dos drivers instalados. O registrador é acessado pelo software 
Log-Graph como um dispositivo em uma porta serial. Isso requer a 
instalação dos drivers do Windows que estão localizados no arquivo .Zip 
disponibilizado para download no site da Incoterm (veja instalação em: 
2.7.3 “Instalação de dispositivos”).

Os parágrafos 2.1 a 2.6 descrevem as propriedades do registrador e 
do software, o parágrafo 2.7 descreve como instalar os drivers e o 
software.
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Propriedades do registrador e do software

2.1 Especificações do registrador

Os registradores log10/100/110/110EXF possuem as seguintes 
propriedades:

• Temperatura (interna) com resolução de até 0,1 °C/°F
• Umidade (apenas Log110/110EXF) com resolução de 0,1% RH
• Conexão para sensor externo de temperatura (via conector Logger-

USB) (apenas Log100/110EXF)
• Horário de gravação do registrador interno com data/hora
• Até 60.000 registros (20.000 registros para Log10) com intervalos de 

1 segundo a 24 horas 
• Exibição de valores Min / Max / Avg via botão Mode ou 

automaticamente
• Monitoramento de valor limite e exibição via LED e alarme
• Início e parada via:

a)  Botão Start/Stop
b)  Indicação de tempo
c)  Duração ou número do registro

• Funções de economia de energia

2.2 Especificação funcional do software

O software é usado para configurar os parâmetros operacionais, ler e 
arquivar os dados registrados e exibir o status operacional. As seguintes 
funções estão disponíveis:
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2.2.1 Configurações do registrador:

Ÿ Lê e configura a data e o horário do registrador
Ÿ Exibe o status da carga da pilha
Ÿ Lê e configura o intervalo de gravação
Ÿ Configura a memória (tempo de gravação/número de 

registros/memória circular)
Ÿ Inicia e pára a gravação
Ÿ Controle do início de gravação: tempo/botão/início imediato e 

proteção contra início múltiplo
Ÿ Controle de parada: tempo/duração/número de registro/botão/ 

infinito (memória circular)
Ÿ Estabelecer os valores limites de alarme (LED/alarme), atraso de 

alarme, acúmulo de alarme.
Ÿ Ativa o alarme do sensor externo
Ÿ Unidades °C ou °F
Ÿ Configurações de economia de energia para o visor LCD, os LEDs e o 

alarme
Ÿ Configurar intervalos para o visor LCD, os LEDs e o alarme
Ÿ Trava para botão Mode
Ÿ Dados de identificação do registrador definidos pelo usuário.

2.2.2 Status do registrador:

Ÿ Visão geral do hardware e da identificação do registrador
Ÿ Visão geral do status operacional do registrador
Ÿ Entradas de registro dos valores limite excedentes e erros ocorridos
Ÿ Visão geral de todos os parâmetros disponíveis no registrador
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2.2.3 Registros:

Ÿ Valor instantâneo exibido durante o processo de registro
Ÿ Leitura dos dados registrados
Ÿ Apresentação em forma de tabela e gráfico
Ÿ Adição de observações nos registros existentes
Ÿ Impressão dos registros (tabela ou gráfico) e observações como 

relatório

2.2.4 Operações:

Ÿ Configuração da entrada USB (busca automática)
Ÿ Início e parada do registrador através do computador
Ÿ Reset para configurações básicas
Ÿ Guardar e carregar configurações do registrador

2.3 Requisitos do sistema

O software foi criado para computadores com sistema Windows (de 
Win 98, Win ME, 2000, XP, Vista, Win 7). A instalação requer as 
seguintes condições:

Ÿ Computador padrão de 386 em diante com teclado e mouse (ou 
dispositivo equivalente);

Ÿ CD-ROM (para instalação) ou acesso à internet (para instalação);
Ÿ Entrada USB disponível;
Ÿ Resolução gráfica 800 x 600 ou mais;
Ÿ Aprox. 10 MB de espaço livro no disco rígido para instalação;
Ÿ Registrador LOG10/100/110/110EXF.
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Sistema operacional de 32 bits Windows® (pelo menos Win98 em 
diante) ou um sistema operacional mais moderno Windows® (32/64 
bits). Uma configuração segura do sistema operacional instalado é um 
pré-requisito para o funcionamento adequado do software Log-Graph.

2.4 Conteúdo do pacote do software

O pacote do software inclui os seguintes componentes

Ÿ Rotina de instalação em alemão/inglês/francês;
Ÿ O programa em alemão/inglês/francês;
Ÿ Arquivos de ajuda em alemão/inglês/francês;
Ÿ O manual em formato PDF em alemão/inglês/francês/português;
Ÿ Dispositivos para uso do registrador na entrada USB.

No download do software, todos os arquivos mencionados acima 
também estão incluídos em Setup.exe.

O manual tornará a instalação do software Log-Graph mais fácil e 
rápida.

2.5 Comunicação entre o computador e o registrador

Para comunicar, o registrador e o computador utilizam a entrada USB 
que é configurada como entrada COM serial via drivers (similar a um 
adaptador serial USB).
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2.6 Primeira conexão de um dispositivo

Ÿ Para configurar o registrador, proceda conforme descrito no manual 
de instruções do instrumento. O registrador estará pronto para operar 
e ser conectado ao computador.

Ÿ Conecte o registrador ao computador através do cabo USB.
Ÿ Quando você conectar o registrador pela primeira vez, não haverá 

drivers disponíveis. O sistema operacional detecta um “novo 
hardware desconhecido” e auxilia na instalação dos drivers 
necessários. Quando o software já tiver sido instalado, os Drivers 
ficam localizados na pasta “Drivers” do diretório do programa onde o 
software foi instalado.

Ÿ Para instalar, proceda conforme descrito logo abaixo.

2.7 Instalação do software Log-Graph

O software Log-Graph pode ser baixada pela internet no site da 
Incoterm. Para operar adequadamente o registrador no computador, é 
necessária a instalação dos drivers que ficam localizados na pasta 
“Drivers” do diretório do programa onde o software foi instalado.

Obs.: Antes de conectar o registrador Log10/100/110/110EXF ao 
computador, você deverá instalar o software e os drivers.
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LED 
Indicação Ação 

 

Ambas as luzes de LED Desligadas 
 

Registro não ativo 
Ou 

Bateria fraca 

Começa a registrar.  
 
Substitua a bateria e 
descarregue os dados. 

 

Uma luz verde a cada 10 segundos. * 
Registro ativo, sem condição de alarme** 

 
Verde pisca duas vezes a cada 10 segundos. 

Início adiado 

Para começar, segure o 
botão de início até o 
LED Verde e  o Amarelo 
piscarem. 

 

Vermelho pisca uma vez a cada 10 segundos.* 
Registro ativo, condição de alarme para UR baixa*** 

 
 

Vermelho pisca duas vezes  a cada 10 segundos.* 
Registro ativo, condição de alarme para UR alta***  
 

Vermelho pisca uma vez  a cada 60 segundos. 
Bateria fraca**** 

Se estiver ativo, o 
registrador vai parar 
automaticamente. 
Nenhum dado será 
perdido. Substitua a 
bateria. 

 

Amarelo pisca uma vez a cada 10 segundos. * 
Registro ativo, condição de alarme para TEMP 

baixa*** 
 

Amarelo pisca duas vezes a cada 10 segundos. * 
Registro ativo, condição de alarme para TEMP alta*** 

 
Amarelo pisca uma vez a cada 60 segundos. 

Memória do Registrador cheia 

Dados Baixados 

 

2.7.1 Instalação através do download da internet

a) Após baixar em www.incoterm.com.br/software_log/setup.zip e 
descompactar o conteúdo em seu PC, execute o arquivo “setup.exe” para 
instalar o software e copiar os dispositivos em um sub-diretório "\Driver" 
no diretório do programa selecionado.

b) Siga as instruções da rotina de instalação. Durante a instalação, um 
diretório para instalação do software lhe será proposto: 
Programs\Log-Graph (pode ser alterado se necessário). 

c) O processo de instalação cria um grupo de programas no diretório 
selecionado e um atalho do programa chamado "Log-Graph".

d) Para executar o programa, clique duas vezes no ícone do programa 
"Log-Graph" na área de trabalho ou use a seqüência: Iniciar->Todos 
os Programas->Log_Graph->Log_Graph.

e) Além do programa "Log-Graph.exe”, os manuais, os arquivos de 
ajuda e os drivers necessários para a instalação, estão localizados no 
arquivo ZIP.

2.7.2 Instalação dos drivers para conexão USB

Os registradores Log10/100/110/110EXF precisam da instalação dos 
drivers, que estão incluídos no arquivo ZIP.



-14-

Se o Log-Graph já estiver instalado

Os drivers estarão localizados no subdiretório "...\Driver" do diretório 
do software Log_Graph. 

2.7.2.1 Instalação dos drivers

Conexão do instrumento

Conecte seu instrumento a uma entrada USB do seu computador. 
Uma mensagem aparece indicando que um novo dispositivo foi 
detectado.

Depois o programa de instalação é automaticamente iniciado para 
carregar os drivers necessários.

A instalação é realizada em dois passos:

1. Primeiro, um “Conversor Serial USB” que configura uma entrada 
serial virtual para conexão com o instrumento.

2. Depois uma “entrada serial”, que permite que você opere o 
instrumento através do Log-Graph, é designada para o conversor 
serial USB.
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Primeiro passo

O primeiro passo é instalar o “Conversor Serial USB”.

Marque o item                                e clique "Avançar".

Marque a opção                                                           e clique "Avançar".
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Uma nova janela aparece mostrando o processo de instalação e o 
resultado da instalação:

A primeira parte da instalação é concluída com uma indicação de 
instalação bem sucedida. O driver que acabou de ser instalado 
disponibilizou uma entrada serial.
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Segundo passo

O segundo passo é indicar uma entrada serial. O processo é semelhante 
ao descrito acima. Primeiro, a tela de boas vindas na qual a instalação 
será executada aparece de novo.
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Marque o item                               e clique "Avançar".

Marque a opção                                                           e clique "Avançar".



Uma nova janela aparece mostrando o processo de instalação:
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Em seguida o resultado da instalação:

O instrumento agora pode ser usado com o software Log-Graph.

O nome da entrada serial (de COM1 a COM 256) foi automaticamente 
designado para a entrada USB durante a instalação do dispositivo. O 
software Log-Graph automaticamente detecta a entrada designada. 
Você também pode encontrá-lo através das configurações do sistema, 
onde o nome da entrada pode ser alterado.

3 Trabalhando com o software Log-Graph

Este capítulo descreve a estrutura do software Log-Graph e fornece 
informações sobre sua operação. Presume-se que o usuário está 
familiarizado com a operação do computador e as funções gerais do 
sistema operacional Windows ®.
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Estrutura da interface do usuário
A operação do software é realizada pela barra de menu ou pela barra 

de ferramentas. Selecionar um item do menu abre uma nova janela na 
qual os próximos passos da operação do software serão realizados.

Barra de menu:
Diferentes grupos do menu do programa estão localizados na barra de 

menu. Após clicar em uma opção, o grupo do menu correspondente abre 
e oferece novas possibilidades de seleção.

Barra de ferramentas:
Os ícones para funções usadas com frequência estão localizados na 

barra de ferramentas. Após clicar em um ícone, a função apropriada é 
diretamente executada.

Visualização online:
Os principais dados do Registrador conectado são mostrados no 

Status, no lado esquerdo da tela.
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Área do gráfico:
Os gráficos e tabelas são exibidos na área do gráfico, do lado direito 

da tela.

Linha de status:
Na parte inferior da tela, uma linha de status mostra informações 

sobre as operações em andamento.

Obs.: O tamanho da janela pode ser alterado usando as margens da 
estrutura da janela e arrastando-as com o mouse. A caixa “Minimize” 
transforma a janela em um ícone e a "Maximize" expande a janela em tela 
inteira. "Close" permite sair.

Interface do usuário

A operação do software é realizada pela barra de menu ou pela barra 
de ferramentas. Selecionar um item do menu abre uma nova janela na 
qual os próximos passos da operação do software serão realizados.

3.1 Barra de menu

Temos os seguintes grupos do menu: File, View, Logger, Graph, 
Window e Help. Cada item do menu está brevemente descrito abaixo:
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3.1.1 Menu File

Setup of logger descriptions: Busca os dados característicos do 
Registrador  que está conectado ao PC.

Language setting:  Permite que você selecione as 
configurações de idioma.

Print: Imprime uma cópia do conteúdo da tela 
exibido atualmente.

Exit: Permite que você saia do programa.

3.1.2 Menu View

Toolbar: Exibe ou oculta a barra de ferramentas 
na parte superior da janela.

Status bar: Exibe ou oculta a barra de status na parte 
inferior da janela.

Online-Status: Exibe ou oculta as informações do 
Registrador.

Background picture: Exibe ou oculta a imagem de fundo na 
janela de gráfico.
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3.1.3 Menu Logger

Display the logger status: Abre uma janela que exibe o status do 
Registrador;

Logger-quick start: Inicia a gravação do Registrador usando as 
configurações atuais;

Logger-quick stop: Interrompe a gravação do Registrador;
Logger setup (program): Abre uma janela para configurar o 

Registrador;
Readout logger records: Abre uma janela para ler os dados do 

Registrador;
Set logger time: Permite configurar o relógio e a data do 

Registrador;
Setup of logger descriptions: Abre uma janela que exibe dados de

 identificação do Registrador.

3.1.4 Menu Graph

Se nenhum gráfico estiver aberto, apenas o item de menu "Load 
measurement file" é disponibilizado.

Load measuring file: Carrega um arquivo já salvo.
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Quando um gráfico está sendo exibido, os seguintes itens do menu 
são disponibilizados.

Graph: Exibe apenas o gráfico;
Side by side view: Exibe os valores em gráfico e em tabela 

(lado a lado);
View on above: Exibe os valores em gráfico e em tabela 

(gráfico acima da tabela);
Spreadsheet: Exibe apenas os valores em tabela;
Load measurement file: Carrega um arquivo já salvo;
Copy: Copia o gráfico para edição, como bitmap 

ou metafile;
Save as: Salva o gráfico em um dos vários formatos 

(JPG, WMF,EMF ou BMP);
Print (Graph/Spreadsheet):Imprime uma cópia do conteúdo da tela 

exibido atualmente (gráfico e tabela, 
somente gráfico, somente tabela...);
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Display legend: Exibe ou oculta a legenda do gráfico;
Grid line: Exibe ou oculta as linhas de grade 

horizontais e verticais, no gráfico;
3D-three-dimensional: Habilita ou desabilita a visualização gráfica 

em 3D;
Zoom: Permite aumentar, diminuir e restaurar o 

tamanho inicial do gráfico;
Graphical presentation: Permite configurar valores máximos e 

mínimos do gráfico (tempo, temperatura, 
espessura da linha, intervalo de tempo);

Edit notes: Permite salvar um arquivo em formato de 
bloco de notas.

3.1.5 Menu Window
 

Os itens deste menu somente estarão disponíveis quando múltiplos 
gráficos estiverem abertos simultaneamente (janelas).

Arrange: Organiza as janelas em ordem de exibição;
Overlapping: Empilha as janelas umas sobre as outras, 

permanecendo visíveis;
On above: Organiza as janelas uma acima da outra;
Side by side: Organiza as janelas lado a lado;
Minimize all: Transforma as janelas em ícones;
Close all: Fecha todos os gráficos abertos.
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3.1.6 Menu Help

Index F1: Exibe índice de ajuda com os textos e 
termos usados;

Notes: Abre um editor de texto para a criação de 
notas gerais sobre o programa;

Info about Log-Graph: Informações breves sobre o software.

3.2 Barra de ferramentas

Na barra de ferramenta, na parte superior da janela e abaixo da barra 
de menu, as funções frequentemente usadas podem ser executadas 
rapidamente.

Obs.: Todas as funções, também são acessíveis na barra de menu 
através dos sub-menus.

3.3 Visualização online

A visualização online fornece o status operacional do Registrador. 
Para isso, ele verifica periodicamente em intervalos de 1 s se algum 
Registrador foi conectado, o status do Registrador é lido e exibido.
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Ÿ Em modo de espera, a conexão é constantemente monitorada e o 
status é lido uma vez no começo do processo. Depois disso, a leitura 
dos dados de status não modificáveis é desabilitada.

Ÿ Em modo de registro, a conexão é constantemente monitorada e o 
status é lido uma vez no começo do processo. Depois, apenas os 
dados de status modificáveis (o número do registro atual e, se 
ativado, os valores medidos atuais) também são lidos.

Ÿ Se estiver em modo offline, não é verificado se o Registrador está 
conectado e a entrada é desabilitada. Nesse caso, apenas as funções 
de exibição e avaliação estarão disponíveis no menu "Graphs".

A troca entre o modo online e offline é realizada na barra de menu no item 
de menu "View -> Online status".

Registrador no modo de espera:

Na visualização Online, apresenta:

• A identificação do Registrador;
•O modo operacional (modo de 
espera ou de registro);
• Status da pilha;
• Data e hora do Registrador; 
• Dados básicos relacionados aos 
registros existentes;
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Sempre são exibidos:

• No campo superior, o nome do Registrador;
• Clicando no ícone do relógio, ao lado da data e hora do Registrador, 

permite que você sincronize o relógio do Registrador com o do 
computador ou que você insira os dados manualmente (apenas em 
modo de espera).

Registrador no modo de registro:

Na visualização online, apresenta:

· • A identificação do Registrador;
· • O modo operacional (modo de espera ou 

de registro);
• Status da pilha;
• Data e hora do Registrador; 
• Status do Registrador;
•Tabela com a medição atual e os 
valores mínimo e máximo;

Observações:

- A tabela com os valores atuais podem ser 
ocultados.

- No modo de registro contínuo, não é 
possível alterar os dados do relógio do 
Registrador.
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Software em modo offline:

Se nenhum Registrador estiver conectado ou se a visualização online 
não estiver habilitada, nenhuma consulta de status automática poderá 
ser realizada e o Registrador atualmente conectado será ignorado. 
Apenas funções que podem ser usadas "offline" estarão disponíveis, a 
visualização online é ocultada e apenas a área do gráfico é exibida.

3.4 Área do gráfico

Todas as janelas que exibem gráficos e/ou tabelas são apresentadas 
na área do gráfico. Os arquivos são abertos através do menu “Graph-
>Load the measurement file" e exibidos na área do gráfico, em uma ou 
mais janelas.

Abrir um arquivo permite que você visualize seu conteúdo através de 
tabela, gráfico ou combinando ambos. O tamanho de uma janela depende 
da área do gráfico disponível, mas por padrão é usado dois terços da 
largura disponível e dois terços da altura disponível.
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O tamanho de cada janela pode ser editado de acordo com suas 
necessidades, arrastando as margens com o mouse.

Exibir os dados dos arquivos na área do gráfico – uma ou mais janelas 
– permite que você gerencie a organização dessas janelas no item de 
menu "Window" (ver “Gerenciamento de janelas”).

• A caixa “      “ transforma a janela um ícone.
• A caixa “     “ expande a janela atualmente selecionada para a área 

de gráfico disponível.
• A organização "Horizontal" ou "Vertical" só está ativa com 

múltiplas janelas. Organiza as janelas em filas (horizontal) ou em 
colunas (vertical). O tamanho da janela se adapta à área disponível 
para o gráfico.

• "Window->Overlapping" reduz todas as janelas ao mesmo 
tamanho e mostra as janelas empilhadas umas sobre as outras, 

permanecendo todas visíveis.
• " Window->Minimize all" transforma todas as janelas em ícones.
• " Window->Close all" permite que você feche todas as janelas na 

área de gráfico ao mesmo tempo.

3.5 Linha de status

A linha de status na parte inferior da janela contém informações sobre 
o atual status do programa ou operações atuais.

A entrada usada é especificada no primeiro campo depois segue o 
status geral da entrada no segundo campo e as operações atualmente 
realizadas são exibidas no terceiro campo.
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As marcações "T", "P", "R" e "W" em Mode no terceiro campo e a cor 
de fundo tem os seguintes significados:

Em relação aos campos destacados em cinza, atualmente não há 
operação, em relação aos campos destacados em verde, a operação 
marcada está acontecendo.

"T" indica uma operação que é automaticamente acionada por tempo 
(Timer)

"P"      indica uma operação que é acionada pelo programa (Program).
"R"      indica uma operação de leitura (Read, lê os dados),
"W"     indica uma operação de escrita (Write, grava os dados),

Às vezes a comunicação acionada por tempo e pelo programa pode 
ser sobreposta. Nesse caso, uma mensagem curta aparece e a operação 
solicitada será executada quando a anterior for concluída e a mensagem 
for confirmada.

4 Configurações básicas para a operação do software

Ÿ O idioma;
Ÿ A entrada usada para a operação;

Idioma

Quando você inicia o software pela primeira vez (após a instalação), 
deve-se especificar o idioma: “File->Language settings”
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As mudanças só terão efeito no software Log-Graph e não nas 
configurações do sistema (ou outros programas).

“Accept” salvas as mudanças feitas. As mudanças são efetivadas 
imediatamente e serão usadas como padrão.

"Cancel" mantém a opção atual.

Configuração da entrada

Para detecção automática, o Registrador a ser instalado deve ser 
conectado através do cabo apropriado, deverá ser o único Registrador 
conectado (outros Registradores que já estiverem conectados deverão 
ser desconectados).

Todas as entradas disponíveis para conexão são buscadas. As 
entradas que já estão sendo usadas por um Registrador ou que usadas 
por outro programa não serão buscadas.

Cada verificação (entrada, taxa de trasferência) requer 
aproximadamente 2 segundos. Quando um Registrador responde à 
mensagem, ele é encontrado e a busca é interrompida. Os dados 
encontrados são armazenados nas configurações do Registrador.
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4.1 Inicialização do software

Inicialize o software clicando duas vezes no ícone Log-Graph na área 
de trabalho ou pela sequência: "Iniciar> todos os programas-> Log-

Graph".

Quando a conexão com o Registrador é estabelecida com sucesso, a 
seguinte janela de início aparece logo depois:

Quando você inicializa o software, o programa procura um Registrador 
conectado usando o seguinte procedimento:

Ÿ O programa verifica se um registrador está na entrada que foi 
configurada da última vez;

Ÿ Se o Registrador não for detectado, uma mensagem de erro 
aparecerá. Tente conectar o Registrador em outras entradas onde o 
Registrador possa ser configurado ou use o software no modo offline;

Ÿ Após uma busca bem sucedida, a entrada é verificada de novo;
Ÿ Se o Registrador for detectado, seu status é lido exibido na 

visualização online.
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Ÿ As configurações da entrada usada são salvas no arquivo .ini para a 
próxima inicialização do programa;

Ÿ Quando o programa é iniciado pela primeira vez, a entrada USB usada 
pelo Registrador ainda não é conhecida e o programa pede para 
configurar a entrada USB (ver “Configuração da entrada do 
registrador”);

Quando a conexão é estabelecida com sucesso, o status atual do 
Registrador aparece do lado esquerdo da janela.

No modo offline (se nenhum Registrador estiver conectado ou a 
visualização online tiver sido desabilitada), apenas a área do gráfico no 
qual os arquivos podem ser carregados e exibidos é disponibilizada. A 
visualização online é habilitada através da barra de menu "View->Online-
status" quando o Registrador é conectado.

4.2 Programação do registrador

A janela de configuração para a programação do Registrador é aberta 
pelo item de menu "Logger> Logger-Setup (program)" ou pela tecla de 
atalho "     " na barra de ferramentas. Primeiro o Registrador é verificado e 
todos os seus parâmetros necessários para a programação são 
apresentados.

Leva alguns segundos para que todos os dados sejam transferidos e a 
janela de configuração apareça.

Os atuais parâmetros do Registrador são exibidos na janela de 
configuração. Muitos parâmetros não podem mais ser alterados 
enquanto está gravando dados, mas são editáveis no modo de espera. As 
posições editáveis ficam cinza durante o processo de gravação e não 
podem ser alteradas.
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A janela de configuração possui quatro categorias:

Ÿ Start/Stop/Measuring interval;
Ÿ Limits;
Ÿ Display/handling;
Ÿ Description.

Load and Save:

"Load and Save" permite carregar as configurações do Registrador e 
salvar as atuais configurações do registrador com qualquer nome de 
arquivo com extensão padrão "set". Todos os parâmetros, exceto 
indicações de tempo de início e de parada, podem ser gravados nas 
configurações. Ao carregar parâmetros salvos, o horário e a data do 
Registrador assim como os valores de calibração atuais são preservados.

Uma configuração básica do registrador também pode ser carregada 
em "Load". Para isso, o arquivo "\Settings\Default\ Default.set" deve ser 
carregado. Ele restaura o status inicial conforme descrito no manual do 
registrador.
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Close

Permite que você saia do programa.
Obs.: Se mudanças forem feitas e ainda não tiverem sido transferidas ao 
Registrador, uma mensagem de alerta aparece.

Transfer settings

As configurações feitas são enviadas ao Registrador e a janela de 
configuração é fechada. Se a configuração possuir dados inválidos, o 
botão fica cinza até que as correções feitas sejam válidas. Depois da 
transferência das configurações, uma resposta aparece na tela.

Start/Stop/Measuring interval:

As condições de início e parada correspondem àquelas condições da 
programação que foi realizada pela última vez. As configurações de 
tempo de início e parada são verificadas enquanto são inseridas e se os 
valores não forem válidos uma mensagem aparece na tela, e o botão 
"Transfer settings" será desabilitado.

Start settings:

A inicialização do Registrador pode ser feita através do botão 
(start/stop). Estas funções podem ser desabilitadas ao desmarcar as 
caixas apropriadas.
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As outras especificações permitem:

Ÿ· Inicialização através do botão do Registrador,ou do comando do 
computador;

Ÿ· O início imediato após transferir as novas configurações;
Ÿ· O início em um horário predefinido (data e hora).

Ao inserir a data e o horário para inicialização, certifique-se de que 
não são menores que a data e hora atual do Registrador ou maior do 
que a data e hora da parada. O tempo de inicialização não deverá ser 
atingido no momento em que os dados são transferidos ao 
Registrador, caso contrário o programa não completará a 
configuração.

 
Ÿ Para evitar que os dados registrados sejam sobrepostos devido a uma 

reinicialização ocorrida após pressionar o botão, a caixa "Protection 
against multiple start" pode ser ativada.

Stop settings:

A parada do Registrador pode ser feita apertando o botão (botão 
start/stop). Esta função pode ser desabilitada ao desmarcar as caixas 
apropriadas.

As outras especificações permitem:

Ÿ O uso da memória interna como memória circular (os registros mais 
antigos são substituídos quando a memória está cheia)

Ÿ A parada assim que a memória está completamente cheia (60.000 
registros)
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Ÿ A parada em um tempo predefinido (data e hora) (*)
Ÿ A parada após um período predefinido (*)
Ÿ A parada após um número predefinido de registros (*)

As especificações marcadas com um asterisco (*) limitam a 
capacidade de armazenamento para um número de registro menor do que 
60000

Ao inserir um tempo de parada, certifique-se de que ele não seja 
menor do que o tempo do registrador ou menor do que o tempo de início. 
O tempo de parada não deve ser atingido no momento em que os dados 
são completamente transferidos ao registrador, do contrário o programa 
não reagirá à entrada do tempo de parada. Uma verificação só ocorre 
durante a entrada.

Measuring interval:

Um intervalo de medição varia de um segundo a 86400 segundos e é 
apresentado em forma de horas/minutos/segundos (hh: mm: ss). Quando 
86400 segundos (24 horas) são alcançados, um dia 00:00:00 aparece.

Certifique-se de que os intervalos de medição não excedam um valor 
de aproximadamente 3,5 horas com a utilização planejada e completa dos 
60.000 registros disponíveis, pois o tempo de vida útil da pilha será 
reduzido comparado ao lapso resultante de quase dois anos.
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Limits:

Os valores mínimos e máximos podem ser predefinidos na categoria 
"Limit values". O registrador emite um alarme se os valores limite 
inferiores ou superiores forem excedidos.

Temperatura e umidade:

Os valores limites são disponibilizados como limite inferior (Lo) ou 
limite superior (Hi) para cada canal de medição. Um sensor externo só 
pode ser usado quando a caixa "Use  external" é ativada. Os valores 
limites inseridos só são usados quando as caixas correspondentes são 
ativadas. Enquanto retém os valores, eles podem ser facilmente ativados 
ou desativados pela simples modificação das caixas.
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Alarm output:

Os valores de medições limites excedentes podem ser sinalizados 
pelo LED vermelho e/ou pelo alarme do registrador. Para a saída de 
alarme, a forma de sinalizar pode ser definida, bem como a taxa de 
repetição e seu tempo de sinalização. As taxas de repetição são limitadas 
a 64 segundos máx. para o LED e alarme, a duração é limitada a 10 s 
máximo em incrementos de 0,5 segundos - cada um com duração 
máxima da defasagem de 0,5 s. Uma defasagem de 0 segundo causa a 
desativação do alarme.

Alarm analysis:

Determina o tempo de atraso (em ciclos de medição) com o qual os 
alarmes devem ser tratados, caso ocorram de forma acumulativa, apenas 
os alarmes permanentes serão sinalizados e cancelados.

AVISO! As sinalizações de alarme correspondentes aparecem 
apenas quando o LED e/ou alarme não foram desabilitados nas 
opções de economia de energia (Uso dos LEDs / Uso do alarme).

Display/Handling:

As configurações gerais para a operação do registrador são 
resumidas na categoria Display/Handling.
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Current logger time:

A data e hora do relógio interno do registrador são exibidas. Após 
clicar no botão "Set", você pode sincronizar o tempo do registrador na 
janela "Set the logger date and time". 

Funções de economia de energia e intervalos de atualização para 
LCD, LEDs e alarme:

Desabilitar o visor LCD (ele fica em modo soneca após um intervalo de 
tempo), desativando os visores LED e o alarme, reduz o consumo de 
energia do registrador e prolonga a vida útil da pilha.

Visor LCD:

Durante o registro, a atualização do visor do registrador é feita no 
ritmo do intervalo de medição. 

Quando a caixa "Use the sleep mode" é ativada, o visor LCD entra em 
modo soneca ao final do tempo de atraso especificado sem que algum 
botão do registrador seja acionado. 
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O registrador não exibe nenhum valor medido apenas o status ("run" 
durante o processo de registro e "LC" em modo de espera). Quando a 
caixa "Off in sleep mode" é ativada, o status não é mais mostrado e o visor 
permanece em branco (até que você use os botões novamente).

LED verde/vermelho:

Os visores LED são usados apenas quando a caixa "Use the LED 
displays green/red" é habilitada. O LED verde sempre pisca na taxa de 
atualização de medição quando a opção "Flash in green at the sample 
rate" é ativada. Em relação ao LED vermelho, pode ser ativada (além das 
configurações feitas em Valores limite), se erros tiverem ocorrido no 
registrador ou se ocorrer ativação.

Alarme:

O alarme só é usado quando a opção "Use the beeper" está ativada.

AVISO! As sinalizações de alarme especificadas na categoria "Limit 
values" aparecem apenas quando o LED ou alarme não foram 
desabilitados nas opções de economia de energia (Uso dos LEDs / Uso do 
alarme).

Visor de temperatura:

A unidade de medição no visor do registrador pode ser ° C ou ° F.

Botão Mode ‘’Release keyboard’’:

O botão Mode pode ser travado.
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Nomes ‘’Description’’:

Até oito dados de identificação contendo, no máximo, 16 caracteres 
podem ser armazenados no registrador.

Os nomes só são carregados quando essa categoria é exibida.

Insira aqui qualquer nome que permita identificar o registrador.

4.3 Leitura do registrador

A leitura dos dados registrados é feita pelo item de menu "Logger-
>Readout logger records" ou pelo atalho na barra de ferramentas. 
Primeiro a funcionalidade operacional do registrador é verificada e todos 
os parâmetros necessários para a programação são recuperados.

Leva alguns segundos para que todos os dados sejam transferidos e a 
janela de leitura apareça.
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O número dos registros disponíveis, seu tempo de início e parada, a 
duração e o intervalo de medição são mostrados na visão geral.

Apertar o botão "Readout Data" inicia a leitura dos registros. Na parte 
inferior, a barra de progresso oferece uma visão geral do número de 
registros já lidos. É possível terminar a leitura a qualquer momento 
usando o botão "Cancel ... ". Os registros já transferidos são 
completamente desfeitos (mas permanecem disponíveis no registrador e 
não são apagados). A leitura pode ser realizada novamente em qualquer 
momento.

Após ler os registros, todas as informações de status do registrador 
também são coletadas.

Após uma leitura bem sucedida, os registros devem ser salvos. O 
programa propõe um nome de arquivo único que consiste da data da 
transferência. Esta definição pode ser alterada.
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A extensão do arquivo é sempre .dbf (arquivo compatível com dBase 
III). A informação de status é salva com o mesmo nome, mas com a 
extensão .set. Aperte "Save" para salvar os arquivos.

Após salvar os registros, os valores podem ser exibidos em forma 
gráfica/tabular.

Para isso, clique em "Display graph". Os dados aparecem em uma 
janela da área do gráfico e podem ser futuramente processados.

"Close" permite que você saia da tela.
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4.4 Configuração do tempo do registrador

A sincronização do relógio interno do registrador é realizada pelo item 
de menu "Logger->Set logger time" ou pelo atalho na barra de 
ferramentas. Se estiver em operação, não é possível modificar o tempo 
do registrador.

A janela exibe o tempo de registrador atual e, como comparação, o 
tempo atual do computador.

Dependendo da seleção, o tempo do computador pode ser 
diretamente aceito ou configurado em qualquer outro valor.

Imediatamente após a sincronização, pode haver pequenos desvios 
na exibição do relógio do computador e do relógio do registrador ((+/-1 
segundo) devido ao atraso na transmissão de dados).

"Save date/time" permite definir o tempo do registrador no valor 
especificado.

-47-

 



4.5 Exibição do status do registrador:

A exibição do status dos parâmetros atuais do registrador é feita pelo 
item de menu "Logger->Display logger-status" ou pelo atalho na barra de 
ferramentas. Primeiro a funcionalidade operacional do registrador é 
verificada e todos os parâmetros necessários para a exibição do status 
são recuperados.

Leva alguns segundos para que todos os dados sejam transferidos e a 
janela de status apareça.

As categorias "Hardware", "Status/Start/Stop" e "Alarms" contêm 
informações no registrador que foram obtidas pelo mesmo ao registrar 
(Status /Start/ Stop), ou que estão invariavelmente ligadas ao registrador 
(hardware). Durante o processo de registro, alguns valores podem variar. 
Clicar em "Update" permite atualizar as informações contidas na página 
atualmente exibida. Quando "Read all ... " está selecionado, todas as 
informações de status são lidas novamente.
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Hardware

Status/Start/Stop

Alarmes/erros
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4.6 Verificação da funcionalidade operacional e leitura de todos os 
parâmetros

Na visualização online, os dados mais importantes são transferidos 
entre o registrador e o computador.

Antes de executar as tarefas já detalhadas (programação, leitura dos 
registros, exibição do status...), a funcionalidade operacional do 
registrador é sempre verificada e o conjunto completo de parâmetros 
sempre é recuperado. As operações realizadas são exibidas nesse 
tempo.

Em caso de erros de comunicação, dicas apropriadas são emitidas. 
Leva alguns segundos para que todos os dados sejam transferidos e a 
janela da tarefa detalhada solicitada apareça.
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5 Apresentação de gráficos e tabelas

Assim que a apresentação do gráfico e/ou tabela é aberta, outros 
pontos de processamento são disponibilizados no menu do programa. 
Eles são usados para mudar as visualizações, para inserir valores chave 
para a apresentação e para exportar dados ou gráficos das tabelas de 
medição.

A apresentação pode ser exibida de três formas diferentes:
Ÿ Como gráfico puro (sem tabela)
Ÿ Como apresentação combinada (gráfico e tabela)
Ÿ Como tabela pura (sem gráfico)

Ao exibir um gráfico pela primeira vez, os valores mínimos e máximos 
do eixo de temperatura e tempo e as escalas na proporção (linhas de 
grade) são automaticamente selecionados. Do lado esquerdo está o eixo 
de temperatura e na parte inferior o eixo de tempo.

No gráfico, os controles para troca de escalas de eixo estão 
disponíveis no lado esquerdo do eixo de temperatura e abaixo do eixo de 
tempo. O valor mínimo e máximo mostrado é alterado usando o botão 
com setas Para Cima/Para Baixo no eixo de temperatura ou o botão com 
setas Para Esquerda/Para Direita no eixo de tempo. Nesse caso, o 
respectivo escalonamento de eixo automático é desabilitado. As 
mudanças sempre são feitas em incrementos do espaçamento da linha 
de grade atual. O escalonamento de eixo automático dos respectivos 
valores mínimos e máximos do eixo é reativado novamente usando os 
botões automáticos Automatic maximum on-off ou Automatic minimum 
on-off.
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Se houver apenas uma série de medições, ela é mostrada em um 
período de 1 segundo (do contrário o gráfico aparece vazio porque 
nenhum ponto único é visível).

Dentro do gráfico, os botões direito e esquerdo do mouse podem ser 
usados para mudar a seção da imagem (veja 5.4.2 Processamento das 
visualizações de gráfico).

5.1 Gráfico e tabela

A apresentação pode ser exibida como gráfico de linha bidimensional 
ou em visualização 3D. Em relação à apresentação 2D, as larguras da linha 
podem ser alteradas. A tabela pode opcionalmente ser exibida perto do 
gráfico ou abaixo do gráfico.

Valor mínimo, máximo e médio

Os valores mínimos, máximos e médios dos dados registrados são 
exibidos perto da tabela (em 5.1.1) ou acima da tabela (para 5.1.2). Esses 
valores são continuamente atualizados durante o processo de registro. 
Ao carregar um arquivo existente, esses valores são calculados 
novamente e exibidos.
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5.1.1 Gráfico e tabela lado a lado

A tabela é mostrada perto do gráfico. A largura da tabela sempre 
permanece a mesma quando muda o tamanho da janela.

 5.1.2 Tabela abaixo do gráfico

A tabela é mostrada abaixo do gráfico. A altura da tabela é sempre um 
terço da altura total da janela.
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5.2 Gráfico (sem tabela)

A apresentação pode ser exibida como gráfico de linha bidimensional 
ou em visualização 3D. Em relação à apresentação 2D, as larguras da linha 
podem ser alteradas.

5.3 Tabela (sem gráfico)

Todos os valores medidos registrados previamente são exibidos na 
tabela. A tabela sempre tem a mesma estrutura. A organização e o 
número de colunas da tabela são os mesmos para todos os dispositivos, 
independente do dispositivo fornecer ou não valores medidos. As colunas 
frontais "Number", "Date" e "Time" sempre são usadas. As outras colunas 
podem ser preenchidas com valores medidos, dependendo do dispositivo 
usado e dos canais de registro selecionados. As colunas para as quais o 
dispositivo conectado não pode fornecer nenhum valor (ex. falta o sensor) 
permanecem vazias.
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Valor mínimo, máximo e médio

Os valores mínimos, máximos e médios dos dados registrados são 
exibidos perto da tabela. Esses valores são continuamente atualizados 
durante o processo de registro. Ao carregar um arquivo existente, esses 
valores são calculados novamente e exibidos.

5.4 Funções para processamento de gráfico

Uma gama de funções é disponível quando o gráfico é exibido. Elas 
são localizadas no menu "Graph" do menu principal (veja 3.2.4 grupo de 
menu "Graph") ou usando a barra de ferramentas no cabeçalho do 
respectivo gráfico. O menu usa os mesmos ícones que a barra de 
ferramentas.

As funções de processamento estão disponíveis durante o 
processamento dos dados arquivados (arquivos previamente medidos). 
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5.4.1 Seleção e configurações de gráfico

Elas são realizadas pelo menu "Graph" no menu principal (veja 3.2.4 
grupo de menu "Graph") ou usando a barra de ferramentas no cabeçalho 
do respectivo gráfico.

O menu usa os mesmos ícones que a barra de ferramentas.

O menu contém, além das funções da barra de ferramentas, os itens 
"Copy", "Save as" e "Load the measurement file".

Exibir gráfico

Apenas exibe o gráfico com os valores já registrados e as escalas de 
eixo.
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Gráfico e tabela lado a lado

Exibe simultaneamente o gráfico do lado esquerdo e a tabela do lado 
direito.

Tabela abaixo do gráfico

Exibe simultaneamente o gráfico na área superior e a tabela na parte 
inferior.

Exibir tabela

Exibe apenas a tabela com os valores já registrados.

Zoom para o tamanho original

A apresentação do gráfico é restaurada em seus valores iniciais. O 
escalonamento de eixo automático é ativado.

Zoom (+)

A apresentação do gráfico é expandida em aproximadamente 110% 
de seus valores anteriores. O escalonamento de eixo automático é 
desativado. Se, por isso, o espaçamento da linha de grade for menor do 
que 1 / 1000 ° C ou menor do que 1 s, a apresentação será adaptada a 
esses valores mínimos.
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Zoom (-)

A apresentação do gráfico é reduzida em aproximadamente 90% de 
seus valores anteriores. O escalonamento de eixo automático é 
desativado. Se, por isso, os escalonamentos da apresentação original 
não forem alcançados, uma futura redução não será realizada.

Entradas manuais

Os valores mínimos e máximos dos eixos de temperatura e tempo 
podem ser alterados manualmente em valores arbitrários por entradas 
manuais. A subdivisão das linhas de grade (ticks) podem variar e a largura 
da linha para a apresentação 2D pode ser estabelecida dentro de uma 
faixa de 1 a 10 pixels. Se a apresentação de um eixo de tempo fixo for 
selecionada, o período máximo mostrado no gráfico é definido.

Visualização em 3D

A apresentação em linha 2D normal é alterada em uma apresentação 
3D e vice-versa.

Linhas de grade horizontais

As linhas de grade horizontais são exibidas ou ocultadas.

Linhas de grade verticais

As linhas de grade verticais são exibidas ou ocultadas.
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Legenda 

A legenda (descrição das curvas de sinal) no canto superior ou direito 
do gráfico é exibida ou ocultada.

Imprimir

"Print" começa a imprimir a seção do gráfico atualmente exibida. Você 
pode escolher entre várias opções. Os valores do gráfico ou da tabela são 
impressos tanto individualmente quanto juntos.

5.4.2 Processamentos das visualizações do gráfico

Além da seleção de funções do menu, algumas funções são 
diretamente realizadas usando o mouse. Algumas funções são ativadas 
usando o botão esquerdo do mouse e outras são ativadas usando o botão 
direito do mouse. 

5.4.2.1 Seleção usando o botão esquerdo do mouse

Quando o botão esquerdo do mouse é apertado, uma seção de gráfico 
pode ser selecionada para maior apresentação ou uma seção maior será 
restaurada em suas dimensões originais.
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Ampliação de seção do gráfico

Se, enquanto mantém pressionado o botão esquerdo do mouse, você 
arrasta o ponteiro do mouse da parte superior esquerda para a direita 
inferior, o gráfico é ampliado para o tamanho desta área quando você 
solta o botão do mouse (com visualização em 3D, o ponteiro do mouse 
deve estar dentro da escala eixo no plano frontal, caso contrário, não 
haverá reação). A escala do eixo automático é desativada.

Restauração de seção do gráfico

Se, enquanto mantém pressionado o botão esquerdo do mouse, você 
arrasta o ponteiro do mouse da parte inferior direita para a superior 
esquerda – diferente do procedimento descrito acima – o gráfico é 
restaurado em seu tamanho original quando você solta o botão do mouse.  
O escalonamento de eixo automático é ativado.

5.4.2.2 Seleção usando o botão direito do mouse

Enquanto o botão direito do mouse é pressionado, a seção do gráfico 
mostrada pode ser deslocada para a esquerda, direita, para cima ou para 
baixo, reduzida ou ampliada em todas as quatro direções dos lados e 
ângulos. Neste contexto, a posição inicial em que você clica com o botão 
direito do mouse determina a próxima operação.

Dependendo da posição inicial, o cursor muda a aparência e indica a 
direção em que você pode se mover. Cinco direções podem ser 
distinguidas:
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-    [1]. Esquerda <> Direita
-    [2]. De cima <> Para baixo
-    [3]. Inferior esquerda <> Superior direita
-    [4]. Superior esquerda <> Inferior direita
-    [5]. Mover

[1] / [2] Redução ou ampliação da seção da imagem a partir das 
laterais

Se, enquanto o botão direito do mouse é pressionado, o mouse está 
em um intervalo de cerca de 0-20% ou 80% - 100% no sentido horizontal 
ou vertical (quase no meio de uma das bordas do gráfico), o gráfico pode 
ser ampliado ou reduzido no sentido horizontal ou vertical, mantendo 
pressionado o botão do mouse. A escala automática dos eixos em 
questão é desativada.

As áreas em que o mouse deve ser localizado para este fim são 
sombreadas.
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[3] / [4] Redução ou ampliação da seção da imagem a partir das 
margens

Se, enquanto o botão direito do mouse é pressionado, o mouse está 
em um intervalo de cerca de 0-20% ou 80% -100% no sentido horizontal ou 
vertical (quase no meio de uma das bordas do gráfico), o gráfico pode ser 
ampliado ou reduzido no sentido horizontal ou vertical, mantendo 
pressionado o botão do mouse. A escala automática dos eixos em 
questão é desativada.

As áreas em que o mouse deve ser localizado para este fim são 
sombreadas.

[5] Movimento da seção da imagem:

Se, enquanto o botão direito do mouse é pressionado, o mouse está 
em um intervalo de cerca de 20% a 80% no sentido horizontal ou vertical 
(quase no meio de uma das bordas do gráfico), o gráfico pode ser 
ampliado ou reduzido no sentido horizontal ou vertical, mantendo 
pressionado o botão do mouse. O escalonamento de eixo automático é 
desativado.
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A área em que o mouse deve ser localizado para este fim é 
sombreada.

5.4.3 Impressão dos gráficos e registros

O gráfico e as séries de medição podem ser impressos 
individualmente ou em conjunto. As várias possibilidades podem ser 
selecionadas como opções.
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Graph and records *)

O gráfico e a tabela com a série de medição são impressos na primeira 
página da impressão.

Printing only the graph

Apenas o gráfico é impresso.

Printing only the records *)

Apenas as séries de medição são impressas. 

Printing with grid lines

As séries de medição podem ser impressas com ou sem linhas de 
grade entre as linhas e colunas.

Headers while printing

Cabeçalhos auto-criados e/ou cabeçalhos padrão podem ser 
impressor nas linhas superiores de uma impressão.

Cabeçalhos auto-criados são aceitos pelo arquivo do dispositivo 
criado inicialmente (se foi criado) e pode ser editado antes da impressão. 
A impressão pode ser alinhada à esquerda, à direita ou centralizada na 
página.
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AVISO!

Se há muitos registros, muitas páginas também podem ser 
impressas. O número de registros ou o número de páginas pode, 
portanto, ser limitado. Para evitar a impressão acidental de um 
grande número de páginas, uma mensagem de aviso / confirmação 
aparece quando há mais de duas páginas.

Selecionar registros

Se séries de medição tiverem que ser impressas, o número de 
registros pode ser restrito. Para este fim, uma seleção de registros pode 
ser feita digitando o primeiro e o último registro ou o número de páginas é 
limitado de acordo com os dados antes de iniciar a impressão.

Páginas a serem impressas

Uma vez que o gráfico e os registros foram selecionados, o número de 
páginas necessário para a impressão é calculado e exibido. Ao limitar o 
número de páginas, o número de registros (valor inicial e final) é corrigido 
automaticamente e exibido para fins de controle. Páginas individuais 
também podem ser impressas.
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Configurar

Com "Setup", as opções disponíveis na impressora podem ser 
adaptadas para impressão. Estes são, por exemplo, o tamanho do papel 
(retrato / paisagem), a resolução e a qualidade da impressora ou o número 
de cópias. As opções disponíveis dependem das capacidades do driver 
de impressora instalado. No entanto, é possível que todas as 
capacidades do seu driver de impressora não sejam usadas quando a 
impressão é feita através de Log-Graph.

Imprimir

“Print” permite começar a imprimir usando as configurações feitas 
anteriormente. Se houver mais de duas páginas, uma pergunta de 
segurança aparece perguntando se você realmente deseja imprimir o 
número da página indicada.

Cancelar 

"Cancel" permite sair do diálogo de impressão e retornar ao ponto de 
partida, sem qualquer outra operação.

A primeira página do formulário impresso tem, por exemplo, a 
seguinte aparência, após selecionar as opções "Print the graph and 
records",  "Use the screen display", "Print with grid lines":
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5.5 Gerenciamento de janela

Todas as janelas do gráfico são incorporadas na janela do programa. A 
localização ou tamanho pode ser ajustado individualmente usando o 
mouse para cada janela. Além disso, existem alguns layouts padrão 
disponíveis de janela que exibem as janelas empilhadas, lado a lado ou 
umas sobre as outras.

Apresentação em cascata

As janelas são exibidas empilhadas umas sobre as outras, enquanto 
todos permanecem visíveis. Este arranjo é particularmente útil quando há 
um maior número de janelas, porque você pode trazer a janela desejada 
para o primeiro plano - enquanto o tamanho permanece inalterado - após 
clicar no título da janela.

Há também dois outros padrões de organização: vertical e horizontal.
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Em ambos os casos a divisão da janela é feita de tal forma que todas 
as janelas são exibidas simultaneamente e seu tamanho é ajustado para o 
espaço disponível. Se houver um pequeno número de janelas, elas são 
dispostas em uma linha (vertical) ou em uma coluna (horizontal). Se 
houver um número maior de janelas, várias linhas e colunas são usadas 
para exibição.

Com organização vertical, você usa mais colunas do que linhas e com 
organização horizontal, mais linhas do que colunas.

Se você selecionar "Minimize all", todas as janelas são minimizadas e 
dispostas como ícones na parte inferior da tela.

Se você selecionar "Close", a janela ativa é fechada.

Se você selecionar "Close All", todas as janelas são simultaneamente 
fechadas.

Apresentação horizontal
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Apresentação vertical

6 Editor Log-Graph

O editor integrado na Log-Graph permite introduzir notas em uma 
aplicação ou um arquivo de medição e abrir (simples) arquivos de texto 
em uma forma similar ao Microsoft ® NotePad.
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As funções disponíveis são Abrir, Salvar e Imprimir um arquivo, 
Copiar, Colar ou Recortar um texto para a conexão com outras aplicações 
através do clipboard.

Quando você clica no ícone do editor no ambiente Log-Graph, um 
nome de arquivo automático referindo-se ao ambiente é sempre 
atribuído.

Com arquivos de medição, o nome do arquivo de medição é usado 
automaticamente e é dada a extensão ".txt" (por exemplo, para um 
arquivo Pro12_20040723-1.dbf o nome Pro12_20040723-1.txt).

As notas gerais que serão criadas no menu "Help" no programa 
principal receberão automaticamente o nome de "Log Graph.txt".

A nomeação automática é projetada para facilitar a tarefa. Os 
arquivos também podem ser armazenados com diferentes nomes.

Quando você clica no ícone do editor, Log-Graph sempre procura os 
arquivos já existentes com o mapeamento do nome atribuído 
automaticamente.

Os arquivos renomeados deve sempre ser carregados explicitamente 
usando o item de menu "File-> Open".
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